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Short Description - Overall Concept 

Example 

 

What is OCRHotspot? 
OCRHotspot is a software for generating hotspot files, such as those needed for the creation of elec-
tronic spare parts catalogs. 

For drawing files in pixel format (TIFF, PNG, JPEG), you can use OCRHotspot to create attribute files in 
which the information is stored about where position numbers are displayed in the drawing files. In the 
spare parts catalog, these serve as a "hotspot" for linking to the corresponding part in the parts list. 

How does OCRHotspot work? 
OCRHotspot assists you in the creation of hotspot files through an integrated OCR ("Optical Character 
Recognition") component, which specializes in the recognition of position numbers in drawings. In ad-
dition, the software offers you the possibility to define or correct hotspots interactively. 

What can I do with the hotspot files? 
You can use the hotspot files created with OCRHotspot immediately if you use the SpareParts365 soft-
ware. OCRHotspot creates hotspot files in the appropriate format ".hspx". 

If you use other tools for the creation of electronic spare parts catalogs, the XML and CSV formats, 
which are also possible, can be used to transfer the hotspot data directly or by simple reformatting into 
your creation process. 
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How good is OCRHotspot? 
Any tool can only be as good as the data you process with it. With OCRHotspot, however, you have a 
tool at hand that is specialized in the processing of drawings of different quality, thus enabling maxi-
mum automation in the recognition of item numbers or the creation of hotspot files. 

What are the limitations of OCRHotspot? 
The limitations of OCRHotspot lie in the quality of the drawing files; if the position numbers are too im-
precise for automatic character recognition, you will have to rework them manually. 

However, a wide range of configuration and training options can significantly improve the result of au-
tomatic hotspot generation. 
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Requirements 

Environment 
• Work PC or notebook with a sufficiently large display (at least 1280 x 1024) 

• 64-bit operating system, x64-based processor 

• Memory (RAM) 16 GB or more; 8 GB sufficient for smaller drawings 

• Windows 10, 11 

Permissions 
You may need local administrator permission to install OCRHotspot. 

Drawing Types 
With OCRHotspot you can process the following file types: 

• Pixel files in TIFF, PNG, or JPEG format 

• Multipage TIFF files →  depending on license type 

Hotspot Files 
OCRHotspot reads and writes hotspot files in the following formats: 

• .hspx: Application-neutral XML file 

• .csv: Separator-separated text file, configurable →  depending on license type 

For a description of the possible hotspot format, see Hotspot Files. 

Other output formats for hotspot files on request. 

Usage 
OCRHotspot is compatible with the spare parts catalog and service information system SpareParts365 
of SpareParts365 GmbH (www.spareparts365.com).  

The application-neutral XML files (".hspx") can be easily converted into hotspot files of other systems 
for electronic spare parts catalogs or similar applications. 

Support for other target systems on request. 

http://www.spareparts365.com/
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License 
The use of OCRHotspot requires the purchase of a temporary or permanent license. 

The functionality available depends on the type of license purchased.  

Important note: Various features described in this document are only available as part of certain 
license options – see the overview under "Overview of License Variants". 

Restrictions 
OCRHotspot is not suitable for use on mobile devices (smartphone or tablet) and does not support 
touch operation. 
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Hotspot Files 

Description of hotspot formats 
OCRHotspot currently supports the following hotspot formats: 

".hspx" format: application-neutral XML file 

Structure of a .hspx file 

Meaning of the elements: 

Name Meaning 

Hotspot Description of a hotspot with the coordinates "Top", "Bottom", "Left" 
and "Right" 

Text Text of the hotspot, e.g. the detected position number 

Type "Normal" (reference to part) or "Modules" (reference to assembly) 

Unsure Specifies whether the text of the hotspot was recognized as "approx-
imate" by automatic character recognition 

Form "Rectangle" or "Ellipse" - representation of the hotspot 

Top, Bottom, Left, Right Coordinates of the hotspot as a fraction of the drawing - between 
"0.000000000" and "0.999999999", relative to the upper left corner 
of the drawing file 

RelativeTop, RelativeBottom, 
RelativeLeft, RelativeRight 

Coordinates of the hotspot in pixels, relative to the upper left corner 
of the drawing file 

HotspotPolygon Description of a polygon hotspot as a sequence of single points 

HotspotPolygonPoint Single point of a polygon hotspot 

X, Y Coordinates of a point of a polygon hotspot in pixels, relative to the 
upper left corner of the drawing file 
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Name Meaning 

RelativeX, RelativeY Coordinates of a point of a polygon hotspot as a fraction of the draw-
ing - between "0.000000000" and "0.9999999999", referring to the 
upper left corner of the drawing file 

Example of a .hspx file 
 

<?xml version="1.0" encoding="utf-8"?>  
<Hotspots Version="2.0"> 
 < Hotspot Text="8" Type="Normal" Unsure="false" Form="Ellipse" Top="2464" Bot-
tom="2509" Left="380" Right="426" RelativeTop="0.64519508" RelativeBottom="0.65697827" 
RelativeLeft="0.14785992" RelativeRight="0.16575875" /> 
 < Hotspot Text="7" Type="Normal" Unsure="false" Form="Ellipse" Top="2509" Bot-
tom="2554" Left="500" Right="545" RelativeTop="0.65697827" RelativeBottom="0.66876146" 
RelativeLeft="0.19455253" RelativeRight="0.21206226" /> 
 < Hotspot Text="5" Type="Normal" Unsure="false" Form="Ellipse" Top="2790" Bot-
tom="2835" Left="1175" Right="1220" RelativeTop="0.73055774" RelativeBot-
tom="0.74234093" RelativeLeft="0.45719844" RelativeRight="0.47470817" /> 
 < Hotspot Text="6" Type="Normal" Unsure="false" Form="Ellipse" Top="2680" Bot-
tom="2725" Left="1233" Right="1278" RelativeTop="0.70175439" RelativeBot-
tom="0.71353758" RelativeLeft="0.47976654" RelativeRight="0.49727626" /> 
 < Hotspot Text="2" Type="Normal" Unsure="false" Form="Ellipse" Top="3546" Bot-
tom="3591" Left="1491" Right="1536" RelativeTop="0.92851532" RelativeBot-
tom="0.94029851" RelativeLeft="0.58015564" RelativeRight="0.59766537" /> 
 < Hotspot Text="1" Type="Normal" Unsure="false" Form="Ellipse" Top="3235" Bot-
tom="3280" Left="1491" Right="1536" RelativeTop="0.84708039" RelativeBot-
tom="0.85886358" RelativeLeft="0.58015564" RelativeRight="0.59766537" /> 
 < Hotspot Text="1" Type="Normal" Unsure="false" Form="Ellipse" Top="2277" Bot-
tom="2321" Left="1634" Right="1679" RelativeTop="0.59622938" RelativeBot-
tom="0.60775072" RelativeLeft="0.63579767" RelativeRight="0.65330739" /> 
 < Hotspot Text="3" Type="Normal" Unsure="false" Form="Ellipse" Top="1834" Bot-
tom="1879" Left="1772" Right="1817" RelativeTop="0.48023043" RelativeBot-
tom="0.49201362" RelativeLeft="0.68949416" RelativeRight="0.70700389" /> 
 < Hotspot Text="4" Type="Normal" Unsure="false" Form="Ellipse" Top="1905" Bot-
tom="1950" Left="1800" Right="1845" RelativeTop="0.49882168" RelativeBot-
tom="0.51060487" RelativeLeft="0.70038911" RelativeRight="0.71789883" /> 
 < Hotspot Text="2" Type="Normal" Unsure="false" Form="Ellipse" Top="2188" Bot-
tom="2233" Left="1981" Right="2026" RelativeTop="0.57292485" RelativeBot-
tom="0.58470804" RelativeLeft="0.77081712" RelativeRight="0.78832685" /> 
</hotspots> 

".csv" format: comma-separated text file, configurable 
 The use of this file format depends on the license type. 

Structure of a .csv file 

The structure of the .csv file is configurable, adjustable parameters are: 
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Parameter Possible values in the example 

Header line yes / no yes 

Unit of coordinates Pixels / Percent Percent 

Separator 
 

; 

Naming and order of fields 
 

"Left"; "Top"; "Width"; "Height"; "Type"; 
"Text" 

Quoting of field contents any suitable 
character 

"..." 

Filename extension 
 

.csv 

Naming of the hotspot types 
 

"Part", "Assembly" 

Configuration 

The default configuration of the structure of the CSV file is done by means of an XML file  
"OCRHotspotCSV.config" in the program directory of OCRHotspot. 

You can create your own configuration by copying and pasting this file into the directory "...\Docu-
ments\OCRHotspot". 

Example of a .csv file 
"Left";"Top";"Width";"Height";"Type";"Text" 

"13.966";"49.931";"3.476";"2.138";"Part";"10" 

"14.148";"59.273";"3.461";"2.117";"Part";"15" 

"27.721";"23.196";"3.461";"2.138";"Part";"10" 

"28.461";"14.655";"3.461";"2.117";"Part";"15" 

"30.849";"67.130";"3.476";"2.117";"Part";"12" 

"53.900";"35.104";"2.388";"2.138";"Part";"9" 

"59.749";"38.600";"2.328";"2.138";"Part";"3" 

"78.658";"69.417";"2.131";"2.095";"Part";"1" 

"90.100";"51.587";"2.343";"2.117";"Part";"2" 

"90.402";"58.525";"2.131";"2.095";"Part";"1" 

"88.271";"96.269";"3.900";"2.213";"Assembly";"951" 
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Licenses 
OCRHotspot is available in several license variants. These differ in the range of functions they can use. 

Please note that some of the features described in this guide are only available from a certain license 
variant. 

Overview of License Variants 

Area Function Demo Stand-
ard 

Profes-
sional 

Ex-
pert 

      

Drawing files Import and display TIFF, PNG and JPEG files 
    

 
Convert to TIFF (Group 4), Rotate +/- 90° 

  

  

 
Splitting Multipage TIFF and Creating 
Hotspots 

   

 

 
Split PDF files and convert them to pixel for-
mat 

   

 

Hotspot files Import and display XML format (".hspx") 
    

 
Import and display CSV format 

  

  

 
Import and display other formats1) 

   
1) 

 
Write XML format (".hspx") 2) 

   

 
Configuring and writing CSV format 

  

  

 
Writing other formats1) 

   
1) 

Show Show drawing with hotspots, zoom 
    

 
Displaying and analyzing individual drawing 
elements 

  

  

 
Hide drawing elements 
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Area Function Demo Stand-
ard 

Profes-
sional 

Ex-
pert 

Hotspots Manually create and edit hotspots as a rec-
tangle 

    

 
Manually create and edit hotspots as ellipses 

 
   

 
Creating and editing hotspots from individual 
objects 

  

  

 
Manually creating and editing of polygon 
hotspots 

   

 

 
Accept "approximately" detected hotspots as 
valid 

  

  

Exclusion areas Creating and considering exclusion area 
 

   

 
Create and account for multiple exclusion ar-
eas – relative or absolute size, effect exclu-
sive or inclusive 

  

  

 
Creating of exclusion areas as a polygon 

   

 

Automatic char-
acter recognition 

Character recognition in individual drawings 
using OCR ("optical character recognition") 

    

 
Numeric character recognition (0..9) 

    

 
Automatic size recognition of item numbers 

 
   

 
Definition of reference characters – "training" 
of character recognition 

 
   

 
Recognition of additional characters, also "- _ 
. / \ # +" 

  

  

 
Character recognition in several drawings 
("batch operation") using OCR 

  

  

 
Regular expressions to define valid strings 
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Area Function Demo Stand-
ard 

Profes-
sional 

Ex-
pert 

 
Use only position numbers in frames (circle 
or rectangle) 

  

  

Configurations Creating and editing a configuration 
 

3) 
  

 
Multiple configurations, copy, import and ex-
port 

  
4) 

 

 
"Approximate" match selectable, quick set-
ting 

  

  

Automation Call OCRHotspot without user interface, au-
tomatic hotspot detection of individual draw-
ings or entire directories 

  

  

Languages User interface in German and English 
    

 
User interface in other languages 

   
1) 

Drawing editing Replace position numbers in the drawing 
with text in any font and color 

   

 

License Binding To Windows System UUID 5) 
   

 
Optionally to Windows System UUID, com-
puter name or MAC address 

   

 

Notes: 

1): On request, may incur additional costs 

2): In the demo version, a maximum of 5 hotspots are stored per drawing 

3): A maximum of 5 sample copies per reference character possible 

4): A maximum of 5 different configurations possible 

5): Time-limited trial license 
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Getting Started 

Installation 
Check the installation requirements at Requirements. 

Download the installation package: Download. 

Install the software on your local workstation. You will need local administrator permissions to do this. 

Request and activate your license 
Start the program in the Start menu under "OCRHotspot". 

Invoke the dialog View License with "Info→License" and switch to the license request via Request Li-
cense. 

In the dialog that opens, enter the required data. A license is bound to one workstation at a time and is 
linked to the Windows system UUID. 

Send the license request to info@wm-itsolutions.com. We will send you a license 

file by e-mail. 

To apply the license, call the dialog View License with "Info→License" and switch to "Import License 
File". 

Enter the received license file via file selector or by dragging and dropping. You will also need local ad-
ministrator permissions to do this. 

If you now open the license dialog, you will be shown the license purchased for your workstation. 

Select Configuration 
To create hotspot files, a configuration with different setting values must be activated. 

OCRHotspot provides a sample configuration that is already sufficient for many applications. However, 
you can later create and customize several different configurations, e.g. to support different types of 
drawings. →  depending on the license type. 

Open the Configuration dialog via the  in the toolbar, or via the "Settings" menu→Configuration". 

You will now see a first, preset configuration called "Default", which can be used for the first steps. 

mailto:info@wm-itsolutions.com
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Load Drawing File 
Use the "Open File" dialog to select→ a drawing file in a suitable format (TIFF, PNG). 

The drawing file is displayed and can be zoomed and moved using an overview window or the corre-
sponding buttons. 

Automatically detect hotspots 
Start automatic hotspot detection via "Recognition→Character recognition with automatic size deter-
mination". 

In the left pane of OCRHotspot, the detected position numbers are now displayed in a table. 

In each case, you can see the corresponding drawing section and the recognized item number. If char-
acters are not clearly recognized, the item number is preceded by a question mark (e.g. "?17"); the cor-
responding table row is highlighted in color. In addition, information about a single selected hotspot is 
displayed in a detail window above the table and can also be changed there. 

If you have a good quality drawing that matches the preset parameters of the sample configuration, the 
job is already done. You can skip the following step. 

Edit hotspots 
If one or more of the hotspots are incorrect, because not all position numbers have been correctly rec-
ognized, you can edit the hotspots interactively. 

You can do this in several ways: 

• In the table: 

o Click in the text area of a hotspot, you can then correct the text. 

o Select one or more hotspots (use the Shift or Ctrl keys) and delete hotspots that are mis-
takenly identified as location numbers. 

o If there are hotspots that have been marked as "uncertainly" but have been detected 
correctly, you can select them and mark them as valid using the context menu "Accept 
hotspot texts". The question marks disappear after that. 

• In the detail view: 

o Correct the text of an incorrectly recognized item number and confirm with "Apply". 

• In the drawing area: 

o Select one or more hotspots (using the Shift or Ctrl keys or using a lasso function with 
the right mouse button). 

o Delete unnecessary hotspots using the "Remove" button or the context menu. 

o Edit the text or type of similar hotspots using the context menu. 
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In the case of unrecognized location numbers, you can create hotspots manually: 

• Activate manual hotspot creation via "Create→New hotspot". 

• Use the left mouse button to drag a rectangle over the position number, which can later be used 
as a hotspot. 

• The hotspot first has the text content "???", you can then change it as described above. 

• In this way, set all the missing hotspots on the drawing and finally finish the process with "Can-
cel" in the toolbar. 

Save hotspots 
Once all the hotspots are set correctly, you can place a hotspot file with this information in the same 

directory as the drawing file. To do this, use the command "File→Save hotspot file" or the icon  in the 
toolbar. 

Alternatively, you can switch to another drawing via the file selection dialog or to the next or previous 

drawing using the corresponding buttons in the toolbar  . In this case, a query is made as to 
whether the hotspot file should be saved to the drawing file you just edited. 

Done! 
You have created your first hotspot file, which you can now use in an electronic spare parts catalog, for 
example. 

Please note that some of the features described here are only available from a certain license variant. 
See the overview under Licenses. 
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Working with OCRHotspot - Use Cases 
In this section, the most important real-world use cases are described. 

The detailed description of the features mentioned here can be found in the rest of the documentation. 

Use Case – Create Configuration 

  

Create a suitable configuration 

By creating or customizing configurations, you can optimize the results of automatic hotspot genera-
tion. 

To do this, open the Configuration dialog via the  in the toolbar, or via the menu "Adjustments→Con-
figuration...". 
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Create your own configuration 

In the left area of the configuration dialog, you can see the configurations that already exist. 

Select an existing configuration and copy it or create a new configuration. 

Assign an appropriate name and use the description field to indicate what this configuration is intended 
for. 

Once you've finished adjusting this configuration, you can make it read-only to prevent accidental 
changes. 

Reference characters 

If a special character set was used in your drawings, you can adapt the configuration to it to minimize 
the number of error detections: 

• Delete any existing reference characters in the configuration dialog. 

• Close the configuration dialog and save the changes. 

• Load a drawing with the character set in question, in which as many digits or special characters 
as possible are used. 

• Select an instance of each character - right-click on it - and open "Define reference character" 
dialog Define reference character. 

• In the dialog that opens, enter the displayed character with the keyboard and confirm the entry. 

• If a small character size has been used, or if the representation of the same characters is too 
different, you should mark several copies of each character as reference characters in the man-
ner described (usually a maximum of 3 copies should be sufficient). 

• Now check the result in the configuration dialog: are all the required characters available? Have 
all reference characters been mapped correctly? 

Parameter 

By setting the parameters in the right area of the configuration dialog, you can influence character 
recognition or hotspot generation: 

• Character size and tolerance: specifies the size range in which recognized characters must be 
in order to be interpreted as valid. 

• Limit for reliable and approximate recognition: controls how close the match of a found element 
in the drawing must be with one of the reference characters in order to be interpreted as "valid" 
or "presumably valid". 

• Use all copies of a reference character: this setting allows for higher detection reliability but 
requires higher computing power (or leads to longer runtime). 
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• Maximum distance between characters: specifies how far apart two adjacent characters can 
be from each other in order to be recognized as a related hotspot. 

• Border around hotspot: expands the sensitive area with the recognized position numbers, so 
that the hotspots are easier for the user to click on later. 

You can also adjust the most important of these parameters without opening the configuration dialog 
by displaying the "Parameters" area to the right of the displayed drawing and see the effect on the re-
sults of the hotspot generation immediately. 

      The easiest way to set the desired character size is to right-click a digit between 2 and 9 in the 
drawing and open the "Define character size" dialog. 

Exclusion Areas 

If there are regular areas in your drawings where there may be characters that are not item numbers, 
you can mark the areas as exclusion areas. 

Typical use cases for this are drawing heads or drawing frames. 

Procedure: 

• Check whether it makes more sense to use "exclusion areas" (detection only outside) or "inclu-
sion areas" in your type of drawing and select the appropriate option in the toolbar of the main 

window under "  Exclusion areas→Exclude area". 

• Select "  Exclusion areas→Define area" and drag a matching rectangle in the drawing area 
with the left mouse button. 

• Create multiple exclusion areas if necessary. 

Select Configuration 

If you regularly have different types of drawings to work on, you can switch between the different con-
figurations: 

• In the configuration dialog by selecting the appropriate configuration 

• From the Configurations drop-down menu  in the toolbar 

Use Case – Creating Hotspots 
OCRHotspot offers you different options for creating and editing hotspots. 
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Automatic hotspot generation with size detection 

The easiest way to create hotspots is to start with the "Recognition →  Character Recognition with 
automatic size evaluation" menu in the toolbar. 

In a first step, the software tries to determine what the most likely size of item numbers in the current 
drawing is. 

The automatic hotspot generation is then performed with this size setting. 

      If the drawing contains only a few item numbers, this can lead to incorrect size recognition. In 
this case, set the character size manually (see next section). 

Automatic hotspot generation without size detection 

If the item numbers in your drawings are of the same size, it is sufficient to set the size once. 

To do this, select a digit between 2 and 9 in a drawing with the right mouse button and call up the dialog 
"Define character size". 

You can now start automatic hotspot generation on each drawing using the  ("Character recogni-
tion") button in the toolbar. 

If necessary, use the quick setting of parameters (which can be displayed on the right side of the main 
window) to improve the results of automatic hotspot generation. 

Visual inspection 

Variant 1: Using the table 

• The table with detected hotspots on the left allows you to quickly check the automatically gen-
erated hotspots. 

• For each element found in the drawing, the automatically recognized text is displayed. This 
makes it easy for you to detect faulty hotspots and delete or correct them. 

 

Variant 2: Using the drawing, hide hotspots 

• Use the “  Show→Hide hotspot” menu in the toolbar. 

• Any position numbers that may not be recognized are therefore easily eye-catching and can be 
manually provided with hotspots. 

 

Variant 3: Using the drawing, hide drawing elements 
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• Use the “  Show→Mask drawing” menu in the toolbar. 

• Only the recognized item numbers together with the recognized texts remain visible, making it 
easier to detect any existing errors. 

Add a hotspot manually 

For item numbers that have not been recognized, you can add hotspots manually: 

• Start manually entering hotspots with " Create→Hotspot new" in the toolbar. 

• Over each unrecognized position number, drag a rectangle with the desired size of the sensitive 
area. 

• Finish the manual entry with "Cancel". 

• Enter the texts for the hotspots created in this way. 

      If you want the hotspots to all be the same size, it is sufficient to click in the middle of an item 
number from the second hotspot onwards. The generated hotspot will then be the same size 
as the last hotspot created manually. 

Fix hotspots 

There are several ways to correct values of hotspots: 

• You can move or resize a hotspot selected in the drawing. 

• The text associated with one or more selected hotspots can be changed. 

• You can change the type ("standard" or "assembly") or shape ("rectangle" or "ellipse") of one or 
more selected hotspots. 

Automatic hotspot generation for multiple drawings 

If there are several similar drawings in a directory or directory tree, you can run the hotspot generation 
for all drawings in one step: 

• If the character size is the same, call "Recognition→  Batch recognition" and select the de-
sired directory (optionally with subdirectories). 

• If the character size is different, call “Recognition → Batch recognition with automatic size eval-
utaion" and select the desired directory (optionally with subdirectories). 
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Use Cases – Advanced Features 

Polygon Hotspots 
OCRHotspot allows you to create polygon hotspots. Unlike traditional hotspots (usually rectangles or 
ellipses), polygon hotspots consist of three or more points that together form a polygon of any shape. 

Polygon hotspots can be particularly useful for defining hotspots on overview drawings or photos, es-
pecially if there are no item numbers. However, polygon hotspots cannot be generated automatically, 
but must be created manually. 

Preconditions: 

• Only the application-neutral XML file data format “.hspx” offers the possibility to save polygon 
hotspots. 

• The spare parts catalog creation software must be able to handle polygon hotspots 
(SpareParts365 does not currently support polygon hotspots). 

Procedure: 

• Start the creation of a polygon hotspot via " Create→  Polygon new" in the toolbar. 

• In turn, click on all the positions in the drawing that you want to be vertices of the polygon. 

• For corrections, you can delete the last set item with the Remove key. 

• Finish the creation by clicking “ Accept” in the toolbar or by pressing Enter. 

Regular Expressions 
In certain cases, automatic hotspot generation can be simplified by using regular expressions. 

There are two ways to do this: 

Validation 

You define a regular expression that describes the structure of valid item numbers (for example, 1 - 3 
digits). In this case, only hotspots are created whose text is recognized as matching via the regular ex-
pression. 

This allows you to prevent elements of the drawing from being recognized as hotspots that have a dif-
ferent structure. 
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Substitution 

In addition to the regular expression to check the match, you enter a replacement expression. This will 
replace all texts from hotspots that match the regular expression with texts that result from the replace-
ment expression. 

All non-congruent texts remain unchanged. 

This function can be used, for example, to delete or add leading zeros in position numbers. 

Procedure 

In the configuration dialog, use the dialog “Extended Configuration” via "Extended...". 

In the input fields of the dialog that appears, you can enter a regular expression and a replacement ex-
pression. 

You can also use a test string to determine whether a regular expression or replacement expression will 
produce the result you want. 

For details on regular expressions, see Using Regular Expressions. 

Viewing additional information 
If there are unexpected effects when editing drawings, it can be helpful to display additional infor-
mation. 

File Properties 

By calling "File→  Properties" you will see information about file type, sizes, etc. 

Displaying Object Types 

Use the selection fields under "  Show→..." in the toolbar, you can display different types of objects 
(see Glossary) or disable it: 

• Hotspots: Rectangles or polygons that are stored along with the texts in the hotspot files. 
Hotspots can be created automatically or manually. 

• Characters: Elements of the drawing that, due to their size, could be valid components of 
hotspots. 

• Elements: Sections of the drawing that contain contiguous black areas up to a maximum size 
(128 x 128 pixels). 

When you click on a displayed object, you will see information about it in the details window above the 
table on the left, e.g. the size and security of the detection. 
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Use Cases – Special Cases 
When creating hotspot files for spare parts catalogs, special cases occasionally arise that require sep-
arate treatment. 

Rotated Position Numbers 
In older drawings, position numbers were sometimes drawn in different orientations, i.e. rotated by + or 
- 90°. When generating hotspots with OCRHotspot, proceed as follows: 

Procedure: 

• If each drawing contains location numbers in different orientations, select “Recognition→Re-
tain hotspots”. As a result, existing hotspots will not be deleted during a new detection run. 

• Perform automatic character recognition. All "normal" item numbers are processed in this way. 

• Rotate the drawing via "Edit→Rotate..." in such a way that the remaining position numbers are 
visible normally, i.e. not rotated. 

• Run Character Recognition again. The original rotated position numbers are now also edited and 
added as additional hotspots. 

Conversion to black and white TIFF files 
For simple line drawings, which are very often used in spare parts catalogs, the TIFF/G4 data format is 
suitable. This data format only knows the colors black and white, but produces very well compressed 
files. 

OCRHotspot offers the possibility to convert line drawings that are available in other data formats or 
compression types to TIFF/G4 in order to obtain the smallest possible file sizes. 

To do this, use the call "Edit→ Save as TIFF/G4”. The original file will be preserved and renamed. 

Multipage TIFF files 
If there are several drawings or drawing sheets for an assembly, they are sometimes combined into 
multipage TIFF files. 

OCRHotspot allows you to split such files into individual files per drawing sheet and to generate indi-
vidual, associated hotspot files. 

To do this, use the "Edit→MultiPage TIFF" call. 
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PDF files 
If the drawings are in PDF format, a conversion from this format to a pixel format is required before 
hotspots can be generated. 

You can use "Edit→Convert PDF files" to select a directory of PDF files. In addition, you can set the 
resolution in DPI as well as the desired pixel format (usually PNG) and specify whether only the first or 
all pages of the PDF files should be converted. 

A subdirectory "PNG" is created, in which individual pixel files are created for the pages of the PDF files. 

Saving Debug Information 
If you receive unexpected and inexplicable error messages while working with OCRHotspot, you can 
activate a debug mode under "Adjustments→Logging". 

In this mode, all error messages from the program are recorded in a log file and stored in your "Docu-
ments" directory under "OCRHotspot". 

You can send us this log file for problem analysis. 

Invoking from the command line or from other programs 
As an alternative to interactive use, you can also use OCRHotspot without a user interface. 

This mode is suitable, for example, for the regular automated generation of hotspot files for newly cre-
ated drawing files. 

OCRHotspot can be started from the command line or from another program. If one or more parameters 
are entered when called, OCRHotspot is started in batch mode without a user interface. 

You can get an overview of the possible parameters and result values when calling OCRHotspot in a 
console window, e.g. as "OCRHotspot.exe -help" 

OCRHotspot 1.2 

============== 

Purpose: 

- Does automatic hotspot generation for single drawing or complete directory 

- Creates hotspot files accompanying the drawing files 

 

Please use valid command line parameters. 

Valid command line parameter: 

 -license:<license file>                  License file (default: program data directory 

 -configfile:<configuration file>         Configuration file (default: executable direc-

tory 

 -config:<configuration>                  Configuration to be used (default: last used 

configuration 

 -file:<drawing file>                     Drawing file to be processed 

 -directory:<directory with drawings>     Directory with drawings to be processed 

 -subdirs                                 Process also sub directories 

 -keep                                    Keep hotspots already existing 
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 -ellipse                                 Create hotspots as ellipses instead of rectan-

gles 

 -autosize                                Use automatic character size evaluation instead 

of value from configuration 

 -lang:<language>                         Language to be used for log files ('EN' or 

'DE') 

 -debug                                   Show debug information 

 -help, -?                                Show this help text 

 

Result values: 

 0: OK 

 1: no valid license 

 2: configuration not found 

 3: file not found 

 4: directory not found 

 5: error processing file 

 7: invalid command line parameters 

 8: no file or directory given 

 

The results of the call to OCRHotspot in batch mode are recorded in a log file and stored in your "Doc-
uments" directory under "OCRHotspot". 
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Use Case – Edit Drawing 

 

Rework an existing drawing 
Especially when using old data inventories, it may be necessary to correct or revise drawings before 
using them in an electronic spare parts catalog. 

OCRHotspot provides functions for this. 

Replace Item Numbers 
There can be different reasons for replacing or redrawing the item numbers on a drawing: 

• The quality of older, possibly scanned drawings is unsatisfactory, the item numbers are not easy 
to recognize. 

• The item numbers on the drawings should be highlighted, e.g. by a different color. 

• The display of the item numbers on the drawings is to be standardized subsequently. 

Call 

You can access the “Edit Drawing” mode from the “Edit →Edit drawing” menu or the icon  in the 
toolbar. 
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Font and font color 

You can specify which font and size, as well as in which color the item numbers should be rewritten. 

Background and border 

You can also choose what color you want the background to be, as well as whether you want to sur-
round the line number with a border. 

Customize Hotspot 

Because a different font or size can change the amount of space required for the item number, the 
hotspot can be automatically adjusted to the size of the item number in the new font. 

Result 

You can save the modified drawing as a PNG (for colored content) or TIFF/G4 (for black and white con-
tent) and use it in your electronic spare parts catalogue. 
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Main 

 

Menu Items 

File Menu 

Menu Function Note 

File open Displays an "Open File" dialog where a drawing file can 
be selected. The selected file will be loaded and dis-
played. If a corresponding hotspot file exists in one of 
the supported formats (".hspx", ".sen", "csv"), it will 
also be loaded and the hotspots defined in it will be 
displayed. 

Supported file types: 
".tif", ".png", ".jpg" and 
".gif" 

Next file Loads the next drawing file from the same directory as 
the one currently displayed. 

 

Previous file Loads the previous drawing file from the same direc-
tory as the one currently displayed. 
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Menu Function Note 

Properties Displays the properties of the currently loaded drawing 
file, including size, resolution, color depth, and com-
pression. 

 

Save hotspot 
file 

Saves the currently defined hotspots of the displayed 
drawing in one of the defined hotspot formats as an at-
tribute file for that drawing. 

When switching to an-
other drawing, the corre-
sponding hotspot file is 
automatically saved (on 
demand). 

Close Quit OCRHotspot. In the case of unsaved 
changes, a notification 
and the possibility to 
save them will be made. 

Edit Menu 

Menu Function Note 

Save as TIFF / 
G4 

Converts the currently loaded drawing into a 
black and white image (if necessary) and 
saves it in TIFF / Group 4 format (CCITT Group 
4). 

This format has a very good ratio 
of data volume and quality in 
black and white drawings and is 
suitable for the creation of spare 
parts catalogs. 
The original file will be preserved 
and renamed. 

Rotate by +90° Rotates the currently displayed drawing 90° 
clockwise. Any existing hotspots will also be 
rotated. 

Useful for the presence of rotated 
position numbers on drawings. 
The original file will be preserved 
and renamed. 

Rotate by -90° Rotates the currently displayed drawing 90° 
counterclockwise. Any existing hotspots will 
also be rotated. 

Useful for the presence of rotated 
position numbers on drawings. 
The original file will be preserved 
and renamed. 
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Menu Function Note 

Convert hotspot 
files 

Opens a directory selection dialog. For all 
hotspot files in this directory (if desired also in 
all subdirectories), hotspot files are created in 
the formats defined under "Adjust-
ments→Settings". 

Attention: Hotspot files that may 
already exist in the target format 
will be overwritten. 

Convert PDF 
files 

Opens a dialog with the possibility to select 
the resolution and pixel format in which PDF 
files are to be converted. A checkbox allows 
you to specify whether all pages of the PDF 
files should be converted. 
You will then see the selection of a directory in 
which the PDF files are contained. 

 

Multi-Page TIFF Opens a directory selection dialog. For all 
multi-page TIFF files found in this directory, in-
dividual files with the individual drawing 
sheets are generated. One hotspot file is gen-
erated for each drawing sheet. 

 

Edit Drawing Opens a dialog that can be used to control the 
functions for editing the currently displayed 
drawing. 

The dialog is displayed to the right 
of the main window. 

View Menu 

Menu Function Note 

Zoom + The currently displayed drawing is enlarged by approx. 10%. 
 

Zoom - The currently displayed drawing is reduced by about 10%. 
 

Fit in The currently displayed drawing is fitted into the visible window 
area. 

 

Adjustments Menu 
Menu Function Note 

Configuration... Opens the Configuration dialog. 
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Menu Function Note 

Language Switching the language of the user interface. Available 
languages are German and English. 

To change the language, 
the software must be re-
started. 

Setting Opens the dialog with the basic Settings. Used to specify the 
hotspot formats to be 
used. 

Logging Activates logging mode. Any error messages that may 
occur are stored in a log file in the "Documents →  
OCRHotspot" directory. 

Facilitates the analysis of 
errors that have oc-
curred. 

Info Menu 

Menu Function Note 

About OCRHotspot Opens the dialog with information about the software ver-
sion, etc. 

 

License Opens the License dialog. 
 

Online help Open this user manual. 
 

Toolbar 
Entry Function Note 

 

Open file As in File Menu 

 

Next File As in File Menu 

 

Previous file As in File Menu 

 

Properties As in File Menu 

 

Save as TIFF / G4 As in Edit Menu 

 

Save hotspot file As in File Menu 
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Entry Function Note 

 

Zoom + As in View Menu 

 

Zoom - As in View Menu 

 

Dovetail As in View Menu 

 

Configuration Opens the Configuration dialog. 

 Show 
Specify which draw-
ing elements should 
be displayed or high-
lighted. 

Selection: 
• Elements: all recognized elements are marked and 

can be selected. 
• Characters: all elements recognized as possible 

characters are marked and can be selected. 
• Hotspots: all defined hotspots are marked and can 

be selected. 
• Texts: under each hotspot, the corresponding text 

(automatically detected or manually entered) is dis-
played. 

• Hide hotspots: all areas belonging to the defined 
hotspots are hidden (white area); this makes it eas-
ier to find unrecognized item numbers. 

• Mask drawing: all drawing elements except the de-
fined hotspots are hidden (white area); This makes it 
easier to check the correctness of the hotspots. 
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Entry Function Note 

 Create 
Creating hotspots 
manually 

Selection: 

•  Hotspot new: Create hotspots by dragging a 
rectangle within the drawing area with the right 
mouse button. Simply clicking with the left mouse 
button within the drawing creates a hotspot at the 
mouse position of the same size as the last manu-
ally created hotspot before. 

•  Polygon new: Create a polygon hotspot of sev-
eral points by clicking on the respective vertices in 
the drawing (only useful if the system for creating 
the spare parts catalogs supports this function). 
You can use the Remove key to delete the last de-
fined points of the polygon. A polygon must consist 
of at least three points. 

•  Hotspot from objects: Allows you to create 
hotspots from one or more elements, characters, or 
hotspots; a surrounding rectangle is formed around 
all selected elements. 

•  Hotspot as rectangle or hotspot as ellipse: 
Specify whether new hotspots are drawn as a rec-
tangle or as an ellipse (applies to both manually and 
automatically generated hotspots. 
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Entry Function Note 

 Exclusion ar-
eas 

Specify drawing ar-
eas inside or outside 
of which hotspots 
should be automati-
cally detected. 

Selection: 
• Define area: Set an exclusion area by dragging a rec-

tangle within the drawing area with the left mouse 
button. 

• Define exclude area as polygon: Set an exclusion 
area by creating a polygon (as with polygon 
hotspots). 

• Delete all exclusion areas: all currently defined ex-
clusion areas will be deleted. 

• Exclude area: the defined areas are excluded from 
automatic detection, alternatively the detection is 
only performed within the defined ranges. 

• Size relative: the size of the exclusion areas is calcu-
lated relative to the drawing size; alternatively fixed 
pixel sizes are used. 

 

Direct call of auto-
matic character 
recognition with the 
currently set charac-
ter size 
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Entry Function Note 

Recognition Invoking automatic 
character recognition 

Selection: 
• Character recognition: automatic character recog-

nition is performed with the currently set configura-
tion parameters. 

• Character recognition with automatic size evalua-
tion: before character recognition, an attempt is 
made to determine the character size of the position 
numbers. 

• Batch recognition: automatic character recognition 
is performed with the currently set configuration pa-
rameters for all drawings in a directory, optionally 
including the subdirectories. 

• Batch recognition with automatic size evaluation: in 
addition, the character size is determined for each 
drawing before character recognition. 

• Retain hotspots: existing hotspots are retained, 
newly recognized hotspots are added (e.g. for draw-
ings with position numbers in different orientations 
or with very different font sizes). 

Configurations Opens a list of all 
currently defined 
configurations, al-
lows you to switch to 
a different configura-
tion. 

If the currently used configuration has been changed in 
the meantime, a query is made as to whether the 
changes should be saved. 

 

Edit drawing As in Edit Menu 

 Accept 
Completes a create 
or edit function and 
applies the changed 
values 

Available at: 
• Move or resize a hotspot. 
• Create or move a polygon hotspot. 
• Creating a hotspot from objects. 
• Move or resize the rectangle exclusion area. 
• Creating or moving a polygon exclusion area. 
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Entry Function Note 

 Cancel 
Cancels a creation or 
editing function. 

Available with all features listed under "Accept", in addi-
tion: 
• Creating hotspots 

Parameter 

Parameter 

Opens or closes a 
display area with the 
most important con-
figuration parame-
ters and allows you 
to quickly set these 
parameters. 

The values can be changed by direct input or by buttons 
within reasonable limits. 
Hotspots that have already been created are deleted 
and regenerated due to the changed setting. 

Shortcuts 

Button or keyboard shortcut Function Note 

Ctrl-A Selects all hotspots. 
 

ESC Removes the current selection or can-
cels the current action. 

 

Return / Enter Completes the current action or 
switches to the input mode of the cur-
rently selected table row. 

 

Home / Pos1 Selects the first hotspot in the table. In combination with Shift 
key: Expansion of the se-
lection 

End Selects the last hotspot in Table. In combination with Shift 
key: Expansion of the se-
lection 

Cursor up/down (except in 
move mode) 

Moves selection in table up / down one 
row. 

In combination with Shift 
key: Expansion of the se-
lection 

Page up/down Moves selection up/down in table page 
by page. 

In combination with Shift 
key: Expansion of the se-
lection 
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Button or keyboard shortcut Function Note 

Delete / Del Deletes all selected hotspots or exclu-
sion areas. 

 

Cursor up/down/right/left 
(while moving an object) 

Moves the object 2 pixels in the specified 
direction. 

In combination with Shift 
and Ctrl keys: Shift by 
larger values 

Ctrl-M Launches the mode for moving or resiz-
ing a hotspot or exclusion area. 

 

Ctrl-N Moves to the next drawing in the current 
directory. 

 

Ctrl-L Switches to the previous drawing in the 
current directory. 

 

Ctrl-O Open the file selection dialog. 
 

Ctrl-R Automatic character recognition on cur-
rent drawing. 

 

Ctrl-S Automatic character recognition on cur-
rent drawing with automatic size evalua-
tion. 

 

Drawing area 
Mouse Commands 

Mouse command Function Note 

Left mouse click Hotspot, character, element, or exclusion area is 
selected. 

In combination 
with Ctrl key: 
Extension or rever-
sal of the selection 

Double-click with the left 
mouse button in the area 
of a hotspot 

Opens the Edit Hotspot dialog. 
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Mouse command Function Note 

Move the pressed-down 
left mouse button 

Moves current drawing section. 
 

Drag rectangle with left 
mouse button 

Depending on action: 
• Create hotspots: creates a new hotspot. 
• Define exclusion area: specifies a new exclusion 

area. 
• Select drawing section: selects drawing section 

to display and enlarges the drawing accordingly. 

 

Drag rectangle with right 
mouse button 

Selects hotspots within the area. Only possible if no 
object is currently 
selected. 

Right-click (context 
menu) – At least one 
hotspot or exclusion 
area selected 

Call of: 
• Clear hotspot(s) or exclusion area. 
• Edit Hotspot(s) – Edit Hotspot dialog. 
• Accept hotspot texts: hotspots marked as "ap-

proximately" are accepted as valid. 
• Resize, move. 

 

Right-click (context 
menu) - mouse pointer is 
over an element 

Call of: 
• Define character size 
• New reference character - Define reference 

character dialog  

 

Rotate the scroll wheel 
of the mouse while hold-
ing down the Ctrl key 

Changes the zoom factor of the displayed drawing. 
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Table of hotspots 
Buttons 

Button Function Note 

Hotspots Hides or shows ta-
ble with hotspot 

For drawings with a lot of hotspots, it can be useful for perfor-
mance reasons to hide the table while editing hotspots in the draw-
ing area. 

A-Z / Z-A Reorders the 
hotspots in the ta-
ble 

 

Mouse Commands 

Mouse command Function Note 

Left-click on table row Table row with hotspot is selected. In combination with Ctrl key: 
• Extension or reversal of 

the selection 
In combination with Shift key: 
• Selection of all hotspots 

between the most re-
cently selected and 
clicked hotspots 

Left-click in the text field 
of a table row 

Edit the text of a hotspot. Accept the text with the Enter 
key or cursor up/down 

Right-click (context 
menu) - At least one 
hotspot selected 

Call of: 
• Delete hotspot(s) 
• Edit Hotspot(s) - Edit Hotspot dialog 
• Accept hotspot texts: hotspots 

marked as "approximately" are ac-
cepted as valid 
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Details view 
Button 

Button Function Note 

Details Hides or shows an area of hotspot details Hide if you want to edit via the table 

Window Elements 

Window element Function Note 

Image Display of the drawing sec-
tion of the currently selected 
object 

Possible objects: 
• Hotspot 
• Polygon hotspot 
• Exclusion area 
• Character 
• Element 

Information to the 
right of the image 

Display of information about 
the selected object 

Information: 
• Type 
• Size 
• Recognition quality (characters) 
• Shape (Hotspot) 

Type Select the type for hotspots: 
"Standard" or "Assembly" 

Can be used to define different types of hotspots 
that result in different behavior in the spare parts 
catalog. 

Text Entering the text associated 
with the hotspot 

 

Accept Applies the changed data of 
the hotspot 

Alternatively: Enter 

Delete Deletes the selected hotspot 
or exclusion area 
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Pan window and zooming 

Example 

 

Function 

Pan window 

The pan window is located in the "Quick configuration" section on the right side of the program window. 
This area can be displayed below the toolbar via "< Parameters". 

The pan window is used to navigate larger drawings. 

Zoom 

The buttons to enlarge the currently displayed drawing are located in the upper left area of the drawing 
window, as well as to the left of the pan window. 

Window Elements 

Pan window 

Window element Function Note 

Slider Changes the zoom factor between 1 and 10. 
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Window element Function Note 

Drawing The section of the drawing currently displayed in the drawing win-
dow is marked by a red rectangle. 
By dragging and holding down the left mouse button, you can 
move the section. 

 

Zoom 
Window element Function Note 

 

The currently displayed drawing is enlarged by ap-
prox. 10%. 

Maximum zoom: factor 
10 

 

The currently displayed drawing is reduced by 
about 10%. 

 

 

The currently displayed drawing is fitted into the 
visible window area. 

 

 

Selection of a drawing area to be enlarged. 
 

 



 

 

 

Version 1.2 Page 49 of 94 

More Dialogues 

Define character size 
Example 

 

Function 

In the "Define Character Size" dialog, you can specify which elements of the drawing should be recog-
nized as possible characters. For this purpose, the values for height and width, as well as a percentage 
tolerance value, are used. 

Once the character size has been set, only those elements whose dimensions match the specified 
height and width within the selected tolerance range are interpreted as "characters". 

Feature 

The height-to-width ratio is roughly the same for digits 2 through 9 for most fonts. Only the digit "1" usu-
ally has a smaller width than the others. When interpreting elements as characters, this is taken into 
account, i.e. if a character recognized as "1" is a smaller width, a smaller width is considered valid. 

The same applies to special characters, such as "+", "-", ".", etc., whose widths or heights differ signifi-
cantly from those of the digits. 



 

 

 

Version 1.2 Page 50 of 94 

Window Elements 

Window Elements Function Note 

Character Detail of the drawing with the selected 
character 

Only drawing elements with a maxi-
mum size of 128 x 128 pixels can be 
selected. 

Character The height and width of the selected 
character are applied. 

 

Current Height and width settings from the 
currently selected configuration 

 

New Depending on your selection: 
• Values " Character" 
• Values "Current" 
• Manually entered values in the 

Height and Width fields 

 

Accept The values under "New" are trans-
ferred to the current configuration and 
used for future hotspot generation. 

 

Cancel The previous values of the current 
configuration remain unchanged. 

 

 

Define reference character 
Example 
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Function 

In the "New reference character" dialog, you can extend the automatic character recognition by an ad-
ditional character or by another example copy of an existing character. 

By defining an element of a drawing that corresponds to a recognizable character as a reference char-
acter, you train character recognition to recognize that character. 

You can define one or more example copies for a character code, such as "9". All reference characters 
of a configuration that have already been defined are displayed in the Configuration dialog displayed. 

Window Elements 

Window Elements Function Note 

Character Detail of the drawing with the selected 
character 

Only drawing elements with a 
maximum size of 128 x 128 pixels 
can be selected. 

Character code If the character is recognized based on ex-
isting reference characters, the corre-
sponding character code is entered here, 
otherwise a "?". 
If the correct character code is not entered, 
correct it by typing a character on the key-
board. 

 Depending on the license used, either 
only digits or arbitrary characters can be 
used. 

 

Congruence If the character was recognized based on 
pre-existing reference characters, the de-
gree of correspondence with the recog-
nized character is indicated here. 
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Window Elements Function Note 

Accept If no reference character has yet been de-
fined for the entered character code, a new 
reference character is created for this 
character code. 
The image shown in "Characters" is stored 
as an example copy of the reference char-
acter for this character code. 
The data is transferred to the current con-
figuration and used for future character 
recognition. 

 

Cancel The previous values of the current configu-
ration remain unchanged. 

 

Reference characters 
You can use the following types of reference characters with OCRHotspot: 

Type Examples Note 

Digits 0 1 2 3 4 5 6 7 8 9 By using digits exclusively, you will get the best recogni-
tion results. 

Capital letters A B C ... X Y Z A reliable distinction between "0" (digit) and "O" (letter) as 
well as "1" and "I" cannot be guaranteed. 

Special character + - * # . , _ < > [ ] { } ( ) For these special characters, OCRHotspot considers the 
sometimes significantly different heights and widths com-
pared to numbers and capital letters. Since the display of 
these characters differs greatly in some fonts, it is not al-
ways possible to guarantee reliable recognition. 

Other characters Lowercase letters, 
other special char-
acters 

Not recommended: The recognition of these characters is 
not guaranteed. 
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Edit Hotspot 
Example 

  

Function 

In the "Edit Hotspot" dialog, you can view and change data from one or more hotspots. 

If only one hotspot is selected, its current properties are displayed. 

If more than one hotspot is selected, the values of the properties are not preset. The changed data will 
be applied to all hotspots. 

Window Elements 

Window Elements Function Note 

Hotspot Section of the drawing with the se-
lected hotspot 

Remains blank when multiple 
hotspots are selected. 

Form Toggle between a hotspot in the shape 
of a rectangle or in the shape of an el-
lipse 

The ellipse property is only supported 
by the application-neutral XML file 
data format “.hspx”. 

Type Toggle between the possible values 
"Standard" and "Module" 

 

Text Related text, typically an item number 
 

Accept The selected properties are applied to 
all selected hotspots. 

 

Cancel The previous values of the hotspot(s) 
remain unchanged. 
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Configuration dialog 

Example 

 

Function 
In the "Configuration" dialog, you can switch between the existing configurations and create, change, 
or delete configurations. 

The currently selected configuration controls the process of automatic hotspot generation. 

By using different configurations, you can adapt the automatic hotspot generation to different types of 
drawings. 

OCRHotspot provides a default configuration "Default", which is sufficient for several use cases. 
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Area “Configurations” 
In this area, you can switch between existing configurations, create new configurations, or delete exist-
ing configurations. 

Window Elements 

Window Elements Function Note 

List of configura-
tions 

Display of all existing 
configurations, select the 
desired configuration by 
clicking on them 

All configurations are stored in a file  
"OCRHotspot.ocrx" in the directory "Docu-
ments\OCRHotspot". 

Name Configuration naming, 
can be changed in this 
field 

 

Comment Additional note about a 
configuration, can be 
changed in this field 

 

Configuration 
read-only 

Makes this configuration 
read-only. The configura-
tion cannot be changed 
as long as it is read-only. 

Use this option to protect completed configurations 
from accidental changes. 

Export The currently selected 
configuration will be ex-
ported and stored in a 
".ocrx" file 

You can use it to save completed configurations or 
transfer them to another workstation. 

Import A previously exported 
configuration is read 
from a “.ocrx” file and 
added to the existing 
configurations. 

 

Delete Deletes the currently se-
lected configuration. 

If you have accidentally deleted a configuration, you 
can restore it from an automatically created backup 
file in the "Documents\OCRHotspot" directory. 
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Window Elements Function Note 

Copy Creates a copy of the 
currently selected config-
uration. 

 

New Creates a new configura-
tion derived from the 
standard configuration 
that came with it. 

The default configuration "Default" is first searched 
in the file "OCRHotspot.ocrx" in the directory "Doc-
uments\OCRHotspot". You can use it to define your 
own default configuration. 
If it is not there, the search will continue in the "De-
fault.ocrx" file in the installation directory of the 
software. 

Area “Reference characters” 
This pane displays all the reference characters defined for a configuration, as well as the sample copies 
of the reference characters. 

Window Elements 

Window Elements Function Note 

Tree with reference 
characters 

The tree contains one main entry for 
each reference character, i.e. for each 
different character code. 
In the child entries of a reference char-
acter, all example instances for that 
reference character (at least one) are 
shown. 
The following actions are possible: 
• Select a reference mark or sample 

copy: by mouse click or with cursor 
keys 

• Expand or collapse tree nodes: by 
mouse click or with cursor keys 

• Delete Currently Selected Refer-
ence Character or Sample Item: 
Remove button 

Deleting the last sample instance for a 
reference character also deletes the 
associated reference character. 
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Window Elements Function Note 

Expand All entries are expanded, all sample 
copies are displayed. 

 

Reduce All entries are collapsed, only the ref-
erence characters with the images 
combined from the sample copies re-
main visible. 

 

Area “Selected character” 
This area displays the currently selected reference character or sample item. 

Window Elements 

Window Elements Function Note 

Picture with char-
acters 

Displays the image of a 
sample instance or a 
combination of the sam-
ple instances of a refer-
ence character. 

 

Delete reference 
character 

Deletes the currently se-
lected reference charac-
ter with all associated 
sample copies. 

 

Delete single char-
acter 

Deletes the currently se-
lected sample instance. 

Deleting the last sample instance for a reference 
character also deletes the associated reference 
character. 
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Window Elements Function Note 

Information about 
the character 

Information about the 
currently displayed refer-
ence character is dis-
played: 
• Associated Charac-

ter Code 
• Relative sizes and 

position in relation to 
"standard charac-
ters" with typical size 

The digits "2" – "9" have similar width-to-height ra-
tios in most fonts. The digit "1", on the other hand, is 
narrower than the other digits in most fonts. 
Special characters such as "+", "-", "_" or "." also 
have different proportions or distances from the 
baseline. In the case of automatic hotspot genera-
tion, these deviations are considered as far as pos-
sible. However, due to sometimes significant differ-
ences in the individual fonts, it is easier for these 
characters to be misrecognized. 

Apply reference 
character 

This checkbox can be 
used to deactivate a ref-
erence character in-
cluded in the configura-
tion. 
It remains in the configu-
ration but is not used for 
automatic character 
recognition. 

 

Area “Character recognition” 
In this area, parameters that are important for automatic character recognition can be changed. 

You can also adjust most of these parameters via the "Quick configuration" in the main window in the 
"Parameters" section. 

Window Elements 

Window Elements Function Note 

Width Specifies the width of elements to be 
recognized as valid. 

 

Height Specifies the height of elements to be 
recognized as valid. 
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Window Elements Function Note 

Tolerance Specifies the tolerance for the height 
and width values in the range of which 
elements should be recognized as 
valid. 

Example: 
• Width 20 pixels 
• Height 30 pixels 
• Tolerance 25% 
Gives the permissible size range: 
• Width 16 – 25 pixels 
• Height 24 – 38 pixels 

Limit for confident 
match 

The "Match" value is determined from 
the discrepancies between a reference 
character or sample instances and an 
element of the drawing. 100% denotes 
an exact match. 
You use this value to determine the 
percentage at which character recogni-
tion is to be accepted as "secure". 

 

Limit for approxi-
mate match  

You use this value to determine the 
percentage at which character recogni-
tion should be assumed to be "likely". 
Characters whose match value is be-
low this limit are not recognized as 
valid. 
Characters whose value of “Match” is 
between the two values for "confident" 
and "approximate" match are indicated 
by a prefixed question mark in the 
hotspot texts, e.g. "?8". 

If the two values for "certain" and "ap-
proximate" match are identical, no 
characters are assumed to be "likely". 
The value for "approximately" must 
not be higher than the value for "cer-
tain". 

Perform a compar-
ison with all indi-
vidual reference 
characters 

Specifies whether automatic character 
recognition compares with each indi-
vidual sample instance, or only with 
the image combined from the sample 
instances. 

The comparison with each individual 
sample specimen allows for better 
recognition quality, but - depending 
on the number of sample instances – 
may require significantly more com-
puting time. 

Area “Adjustments for hotspots” 
In this area, parameters that are relevant for the automatic generation of hotspots can be changed. 
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Window Elements 

Window Elements Function Note 

Maximum charac-
ter distance 

Specifies the relative dis-
tance between two charac-
ters to be interpreted as re-
lated text for a single 
hotspot. 

Values that are too large lead to an unintentional 
merging of hotspots, and values that are too 
small lead to the creation of separate hotspots 
for related characters. 
Fine-tuning this value is necessary if position 
numbers are close together in the drawings and 
at the same time the spacing between charac-
ters within a position number is relatively large. 
This problem applies in particular to fonts in 
which the number "1" is very narrow, but the 
characters are displayed with uniform spacing 
(so-called "non-proportional font"). 

Border around 
hotspot 

Typically, a hotspot should 
not only contain exactly the 
corresponding characters, 
but also a certain tolerance 
range around the characters. 
This makes it easier for the 
user of a spare parts catalog 
to select the hotspots. 

 

Percent / pixel Specifies whether the values 
in "Border around hotspot" 
are absolute (in pixels) or rel-
ative (as a percentage of 
character height). 

 

Other elements 
Window Elements 

Window Elements Function Note 

Extended... Opens the Extended configuration dia-
log 

Specific options for controlling auto-
matic hotspot generation, e.g. via 
regular expressions 
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Window Elements Function Note 

About regular ex-
pressions 

If available, the values from the ad-
vanced configuration are displayed 

 

Accept changes Saves all changes made to the current 
configuration 

 

Close Closes the dialog without saving any 
changes to the configuration 

 

 

 



 

 

 

Version 1.2 Page 62 of 94 

Extended Configuration 

Example 

 

The setting shown in the example removes leading zeros from position numbers, and only considers 
position numbers in frames. 

Regular expressions – functions 
In the "Extended configuration" dialog, you can use regular expressions to specify the permissible syn-
tax of automatically generated hotspots or modify the texts of these hotspots. 

Variant 1: Specifying allowed text strings 

If only the “Regular expression – Source” field is populated, you use it to set the allowed strings for 
hotspots. 

Only hotspots whose detected text matches this expression will be applied. 

Variant 2: Substitution of strings 

If the “Regular expression – replacement” field is also populated, you use it to specify how strings that 
are recognized as valid are to be modified. 
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Texts from hotspots that are recognized as valid by "Regular expression – source" are automatically 
changed via the replacement expression. 

The texts of other hotspots remain unchanged. 

Learn more 

For details on regular expressions, see Using Regular Expressions as well as Regular Expressions. 

Window Elements 

Window Elements Function Note 

Regular expression – source Regular expression to check validity 
 

Regular expression - Re-
placement 

Replacement expression for modifying a text 
 

Test character string Enter any text here to check the effects of validation and re-
placement. 

 

Result of evaluation Test string or replacement result detected as valid 
 

Accept The entered values for regular expressions are copied to the 
current configuration. 

 

Cancel The previous values for regular expressions remain un-
changed. 

 

Special treatment – functions 
For certain cases, additional parameters can be used to optimize hotspot detection. 

Window Elements 

Window Elements Function Note 

Split wider elements Can be used to separate elements that are close 
to each other. 

Especially with blurred 
characters or low resolu-
tion. 
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Window Elements Function Note 

Consider lower case 
letters 

Lowercase letters can be entered as reference 
characters, considering different size ratios. 

The recognition of lower-
case letters is subject to a 
relatively high error rate. 

Greater distance at 
'1' 

Since the '1' is usually narrower than other digits, 
the distance to other characters in so-called 
"non-proportional fonts" can be significantly 
larger – and thus lead to confusion with neighbor-
ing position numbers. 

 

Use only positions 
numbers in frames 

Only position numbers that are within closed ar-
eas (circles, rectangles) are considered. 

Very helpful if drawings 
are created accordingly. 

Limit for distinction 
black and white 

Used to distinguish pixels in drawings that con-
tain grayscale. In this context,  
• '0': black 
• '255': white 

Typical Value: 192 

Special codes for 
configuration 

Possibility to influence the predefined behavior 
of OCRHotspot by means of XML-encoded pa-
rameters. 

Possible parameters are 
displayed as help text. 
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Using Regular Expressions 

Regular Expression to check validity 
Only hotspots whose text matches the configured regular expression will be applied. 

Important elements: 

Element Meaning 

^ Start of text 

$ End of text 

( ) Group, used in substitutions 

| Or, several alternatives are valid 

? Quantity: zero or once 

+ Quantity: at least once 

* Quantity: any number of times 

{<n>} Allowed number: exactly n times 

{<n,m>} Allowed number: at least n times, at most m times 

\d Digit 

[^\d] No digit 

[<Characters>] Description for a character 

[<Characters from>-<Charac-
ters to>] 

Description for a character from the "Characters from" to "Char-
acters to" range 
Examples 
[0-9] exactly one digit 
[a-zA-Z] Lowercase or uppercase letter 

. Any character 
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Substitution of regular expressions 
If the regular expression for validation is correct, the text of the hotspot is replaced by the replacement 
expression. 

Otherwise, the hotspot text will be copied as is. 

Important elements: 

Element Meaning 

$0 Entire Expression 

$<n> nth group of regular expression, denoted by "(..)"; e.g., “$1” 

Examples 

Regular Expressions for validation check 

Regular expression Meaning Examples valid Invalid Exam-
ples 

^[\d]{1,3}$ The text may consist of 1 to 3 digits. 123, 999, 000 0123, 99, 12A, 
123A 

^[\d]{1,2}[A-Z]?$ The text may consist of 1 to 2 digits, op-
tionally followed by one capital letter. 

99, 12A 123, A9, 77BT 

Substitutions 

Regular expression Substitu-
tion 

Meaning Examples of 
substitution 

No substitu-
tion 

^([0]*)(.*)$ $2 Leading zeros are deleted. 001 → 1 
Phone 0999 → 
999 
0A1 A1 →  

1, 10, A00A 

^(\d{2})(\d{2})$ $1-$2 Four-digit numbers are split 
into two blocks separated 
by a hyphen. 

Item 1234 → 
12-34 

123, 12345, 
123A 



 

 

 

Version 1.2 Page 67 of 94 

Further information 
Further information on the use of regular expressions can be found on the Internet, e.g. at 
https://en.wikipedia.org/wiki/Regular_expression 

 

 

https://en.wikipedia.org/wiki/Regular_expression
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Edit Drawing - Replace Position Numbers 

Example 

  

Function 
You can use the "Replace position numbers" dialog to overwrite the existing position numbers at the 
locations on the drawing defined as hotspots. 

Window Elements 

Window Elements Function Note 

Font Selects the font family, font size, and font attributes 
"bold" and "italic". 

 

Font color Specifies the color of the characters. 
 

Draw border Specifies whether a border should be drawn around 
the item numbers. 

The numeric value for 
"Pixel" indicates the line 
width of the border. 
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Window Elements Function Note 

Border color Specifies the color of the border. 
 

Background color Specifies the color of the background of the rewrit-
ten position numbers. 

 

Adapt hotspot size Specifies whether to maintain the original size of the 
hotspots or to adjust them to the dimensions of the 
rewritten position numbers in the selected font. 

Usually useful 

Border around text Specifies how far the hotspot should extend beyond 
the text area. 

 

Percent/pixel Specifies whether the numeric value is to be inter-
preted relative to the size of the font area or abso-
lute in pixels. 

A low value or "0" makes 
sense here 

Accept Applies the set values to the currently displayed 
drawing and replaces the position numbers at the 
hotspots with new position numbers in the specified 
font and with the set colors. 

 

Reset Discards the changes made and restores the origi-
nal drawing. 

 

Save drawing Saves the drawing to a new file. The original file will 
be renamed and will remain as a backup file. 
Possible file formats: 
• TIFF: for black and white drawings 
• PNG: for drawings with colored elements 

 

Close Closes the dialog If changes are not saved, 
a request will be made 
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Settings 

Example 

  

Function 
In the "Settings" dialog, you can specify which of the possible hotspot formats you want to use. 

For each of the three supported hotspot file formats, you can specify whether you want that format to 
be read or written. 

For a description of the possible hotspot formats, see Hotspot Files. 

Window Elements 

Window Elements Function Note 

XML format (.hspx) Selects the application-neutral XML 
format. 

 

PARTS-PUBLISHER 
Format (.sen) 

Selects the format of the hotspot 
files for PARTS-PUBLISHER 
(Quanos). 

 

CSV format (.csv) Selects a format for "comma-sepa-
rated" text files; commonly referred 
to as a "CSV file". 

Depending on the settings in the con-
figuration, the file name extension may 
differ. 

Read When a drawing file is opened, an 
attempt is made to read an associ-
ated hotspot file in the specified 
format. 

The first hotspot file found from the se-
ries of formats marked "Read" is used. 
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Window Elements Function Note 

Write When the hotspot data is written, 
hotspot files are saved in all se-
lected formats. 

A format that is selected for "Write" 
must also be selected for "Read". 

Accept The set values are stored in the reg-
istry area of the logged in user. 

 

Cancel The previous values remain un-
changed. 
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License management 

View License 
Example 

  

Function 

In the "License" dialog, the values of your currently existing license are displayed. 

Window Elements 

Window Elements Function Note 

Status / License file Displays the currently used license 
file. 
If the license is not recognized as 
valid, the reason will be displayed. 
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Window Elements Function Note 

License type Currently activated license type Possible values: 
• Demo 
• Standard 
• Professional 
• Expert 

Version Validity of the license for software 
and version 

 

Serial number Serial number of your license 
 

Valid until Expiration date for a time-limited li-
cense 

 

Customer Specifies the customer to whom this 
license was issued. 

 

Binding Type of binding of the license to 
properties of your workstation 

Possible values: 
• Windows System UUID 
• Host name 
• MAC ID of the network port 

Value Value of the property used 
 

Request new license Opens the dialog for requesting a 
new license. 

See Request License 

Read license File Opens a dialog that can be used to 
apply a new license file. 

The license file is stored in the  
"ProgramData" directory under  
"OCRHotspot" 

Close Closes the dialog. 
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Request License 
Example 

  

Function 

In the "Request License" dialog, you can request a new license for OCRHotspot. 

The values of the currently used license file are copied and displayed. 
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Window Elements 

Window Elements Function Note 

License type Desired license type Possible values: 
• Demo 
• Standard 
• Professional 
• Expert 

New validity period Expiration date for a time-limited or perpetual 
license 

 

Customer Please enter your contact details here and any 
other comments you may have. 

 

Binding Select which type of binding of the license to 
properties of your workstation you prefer. 
Depending on your computer constellation and 
the selected license type, not all properties may 
be selectable. 

Possible values: 
• Windows System 

UUID 
• Host name 
• MAC address (of the 

network port) 

Cause Reason for License Request Possible values: 
• Request a quote 
• Additional license 
• Modification of com-

puter data 
• Change license type 
• Extension of validity 

Via email Your default mail program is called up (via 
"mailto:") and an e-mail is created to 
"info@wm-itsolutions.com". 
In the body area of the email, a text block with 
the data from the dialog is inserted. 

 

Copy to clipboard A block of text with the data from the dialog is 
copied to the clipboard. 
Include this block of text in an email requesting 
a new license. 
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Window Elements Function Note 

Creating file Creates a text file with the data from the dialog. 
Attach this text file to an email requesting a new 
license. 

 

Close Closes the dialog 
 



 

 

 

Version 1.2 Page 77 of 94 

Other features 
OCRHotspot can also make your job easier with a few more features. 

Drag & Drop 

As an alternative to selecting a drawing file via the "Open File" dialog, you can also copy and open a 
drawing file from Windows Explorer via "Drag & Drop" in OCRHotspot. 

Status bar 

The status bar displays some helpful information. 

Field Meaning Note 

Drawing Name of the currently displayed drawing 
file 

Double-click on this field to open 
the "Open File" dialog 

Zoom Displays the currently set zoom factor 
(100% corresponds to the display of the 
entire drawing) 

Double-clicking on this field causes 
the "Fit drawing" function to be 
called, the magnification factor is 
set to 100% 

Position Indicates where the mouse pointer is 
currently located in the drawing. The 
value is given in drawing coordinates and 
refers to the upper-left corner of the 
drawing. 

 

Save changes 
without prompt 

When changing a drawing, the currently 
generated hotspots are saved without a 
security query. 

 

Configuration Displays the currently selected configu-
ration. If changes have been made to the 
configuration that have not yet been 
saved, this field is highlighted 

Double-click on this field to open 
the Configuration dialog  
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Possibilities and limitations 

General 
As already mentioned in Getting Started , the principle of "garbage in, garbage out" also applies to  
OCRHotspot. The better you pay attention to compliance with certain rules when creating drawings (or 
have done so in the past), the better the detection rates for automatic hotspot generation and the lower 
the post-processing effort will be. 

Drawing quality 
When creating drawings, there are several criteria that affect the quality of automatic hotspot detection. 

File format 

In principle, OCRHotspot processes different pixel formats. However, certain data formats are more 
suitable than others. 

The best results can be achieved with black-and-white drawings that have been saved losslessly. 

File format Colours Suita-
bility 

Note 

TIFF Group 4 2 good Best lossless compression for black and white drawings; must 
be converted before being displayed in the browser – usually to 
PNG. 

TIFF LZW any good Compression less good, not processable by a number of pro-
grams 

PNG any very 
good 

Generally useful, especially when colored drawings are 
needed. 

JPEG any less Detection errors due to lossy compression; is suitable, for ex-
ample, for overview drawings with manual hotspot definition 

GIF 256 less Outdated, not useful for technical drawings 

Resolution, character size 

The maximum character size that OCRHotspot supports is 128 pixels. 

Character sizes of less than about 20 pixels are harder to recognize and therefore not recommended. 
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A range between 40 and 60 pixels is optimal, both for the quality of character recognition and for the 
ratio of data volume to display quality. 

If possible, the resolution of the drawings during their creation should be controlled in such a way that 
character sizes of the specified order of magnitude are generated. 

Character set used 

The selection of the character set for position numbers is also relevant for the quality of character 
recognition. 

Keep the following points in mind: 

• If possible, use the same character set for item numbers on all drawings. 

• Don't use exotic character sets. 

• Don't use fonts with very narrow lines, but rather "wider" characters. 

For best results, use purely numeric item numbers. The use of letters and special characters is possi-
ble, but this increases the risk of errors in automatic recognition. Similar characters such as "0" (zero) 
and "O" (capital letter O) or "1" and "I" may not be reliably distinguished. Compound characters such 
as "=" or ":" are not supported. 

Consistency in drawing creation 

As mentioned earlier, you should use the same character set for item numbers if possible. However, it 
is not a problem if different – and distinguishable – character sets are used for different types of draw-
ings. This handles well with multiple configurations. 

On the other hand, it is very helpful to choose a uniform font size for item numbers, which differs signif-
icantly from other characters (dimensions, drawing header, etc.). In this way, the unwanted recognition 
of texts other than item numbers can be prevented. 

Item numbers should also have a uniform orientation. 

If the drawings contain frames and/or drawing header areas, they should be of uniform size and position 
to hide these areas from detection. 

Position numbers in circles 

Currently, position numbers are often displayed within circles (sometimes rectangles) in exploded 
views. In these cases, the option "Only position numbers in frames" from the extended configuration 
area can ensure a very secure hotspot generation. 
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Creation of the drawings 

Naturally, drawings generated directly electronically from a creation system will be best suited for fur-
ther processing. 

With older, scanned drawings, the risk of erroneous recognition increases significantly. 

The recognition of handwritten item numbers is not supported by OCRHotspot. 

Exemption and spacing of item numbers 

To ensure that there are as few false detections as possible, the following important notes should also 
be observed when creating the drawings: 

• The characters of the item numbers must be "cut out", i.e. no drawing elements may touch the 
characters. Occasionally, it can be observed that the connecting lines between an item number 
and the marked drawing element touch the item numbers. In this case, automatic detection is 
not possible. 

• Item numbers usually consist of one or more characters. It is important to note that the mini-
mum spacing between adjacent item numbers is significantly greater than the maximum spac-
ing between the individual characters of a position number. Difficulties can arise in particular 
with the usually narrower digit "1" and the use of fixed-width fonts. 

Configuration 

Default 

The default configuration includes a set of common fonts, which in many cases is sufficient for high-
quality recognition. 

The values for safe and approximate match, as well as for tolerance and maximum character spacing, 
are preset to match typical drawings. 

The character size must be set either once using a typical character or via "automatic character size 
evaluation". 

Options for customization of the configuration  

You can influence the quality of automatic character recognition via various settings in the configura-
tion: 
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Parameter Effect Note 

Reference char-
acter 

The more closely the configured ref-
erence characters match the fonts 
used in the drawings, the greater the 
quality of character recognition. 

 

Multiple refer-
ence characters 

If several examples are defined for 
each reference character, different 
fonts can be recognized. 

However, if you use too many examples 
per reference character, the recognition 
quality can suffer, or the processing time 
can increase significantly. 

Character size 
and tolerance 

The individual characters of the item 
numbers usually have a uniform 
font size. The more precisely the 
font size is narrowed down, the eas-
ier it is to distinguish item numbers 
from other text or drawing elements. 

If the drawings are not created consist-
ently, the character sizes may differ be-
tween the different drawings. This can be 
compensated for by specifying a larger tol-
erance value. However, the detection 
quality may be impaired as a result. 

Limit for sure and 
approximate 
match 

The higher the sure match value, the 
fewer items are incorrectly recog-
nized as valid characters. However, 
valid characters may not be inter-
preted as valid either. 
A lower approximate match value 
will also accept characters whose 
validity is uncertain. These charac-
ters can then be manually deleted, 
accepted as valid or corrected. 

 

Comparison with 
all examples of 
reference char-
acters 

This determines whether the detec-
tion checks each individual example 
of the reference characters for con-
sistency (more reliable but slower) 
or only the averages composed of 
the individual examples (faster but 
less certain) 
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Parameter Effect Note 

Maximum char-
acter distance 

This defines how far apart individual 
characters can be from each other 
in order to be recognized as a re-
lated item number. 

If the value is too large, several adjacent 
item numbers may be combined into a sin-
gle one, and if the value is too small, multi-
digit item numbers containing "1" may be 
interpreted as separate item numbers. 

Regular expres-
sion 

In the extended configuration, a reg-
ular expression can be used to de-
fine which syntax should be allowed 
for item numbers. 

This prevents the unwanted interpretation 
of other text elements in a drawing as 
hotspots. 

Special treat-
ment 

More precise control of hotspot de-
tection via special parameters. 

e.g.: use of item numbers surrounded by 
frames. 

Exclusion areas You can define one or more exclu-
sion areas within or outside of which 
you want to ignore the characters 
you want. 

This allows you to hide texts from uni-
formly created drawing headers, for exam-
ple. 
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Recommendations – Typical Example Cases 

Example 1: Large quantities of inhomogeneous legacy data, medium 
quality standards 
Let's say you have an extensive drawing archive (a few thousand drawing files) that you want to use to 
create electronic spare parts catalogs. As a rule, the drawings have been generated over the course of 
many years, by different creators and with different creation systems. 

They now face a number of challenges: 

• Some of the drawings may be scanned with low quality, some item numbers may be difficult to 
read or smudged. 

• Due to the different creation history, the item numbers are drawn in different fonts and sizes. 

• Some item numbers are too close together or are touched by other drawing elements. 

• In addition to the relevant item numbers, there are other numbers or characters on the draw-
ings, e.g. in the drawing header or as dimensions. 

If you were to set all hotspots manually, you would have to calculate several minutes of time per draw-
ing, including quality control. 

If your quality requirements are limited and you can accept a certain percentage of missing or faulty 
hotspots, there are the following options: 

Variant 1: Fully automatic hotspot generation with OCRHotspot 

Procedure: 

• Use the included "Default" configuration, which includes reference characters from several 
common fonts. 

• Use automatic size detection for item numbers. 

• For character recognition, use the variant "Compare with all individual reference characters". 

Depending on the quality of the drawings, you can expect a recognition rate of 70% - 90%. 

This method requires the most computing power and may require a longer runtime, depending on the 
number of drawings and the size of the drawing. 

Variant 2: Hotspot generation in service 

Procedure: 

• You provide us with your entire stock of drawings. 

• We process your stock of drawings in the manner described under "Variant 1". 
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• We will provide you with the result in the form of hotspot files (at a pre-agreed fixed price). 

Example 2: Large amounts of legacy data, higher quality standards 
With a similar starting point as in example 1, you want to achieve a significantly higher quality of the 
hotspots. 

A purely automatic hotspot generation is not sufficient here, some preparatory and follow-up work is 
required, the extent of which depends not only on the initial data but also on the desired quality level. 

Variant 1: Pre-sorting and use of different configurations 

Presort: 

• Try grouping the drawing inventory so that similarly created drawings are grouped together in 
their own directories. 

• File naming conventions, creation date or source directories may help you with grouping, it may 
be useful to sort the drawing files "visually". 

Automatic hotspot generation: 

• For each of the identified drawing groups, create an individual configuration that is as well 
adapted as possible (reference characters, character size, tolerance range, exclusion areas for 
drawing headers, etc.). 

• For each drawing group, perform automatic hotspot generation with the appropriate configura-
tion. 

Rework: 

• Load all automatically edited drawings in order with OCRHotspot. 

• If the quality of the automatic recognition is significantly worse than expected for this type of 
drawing, you may be able to noticeably improve the recognition rate in the quick configuration 
under "Parameters" by slightly varying individual parameters. 

• Check item numbers with an "approximate" match (indicated by "?.." and color highlighting) and 
delete, apply, or correct them. 

• Perform a visual inspection of the detected hotspots. This can be made easier by the options to 
alternatively hide the hotspots or the rest of the drawing elements. This makes it easier for you 
to determine if item numbers have been missed, or if all recognized item numbers are correct. 

Variant 2: Hotspot generation in service 

Procedure: 

• You provide us with your entire stock of drawings. 
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• We analyze the stock of drawings and provide you with an offer via hotspot generation with a 
desired quality level (e.g. a quality level of 99% means that for every 99 correctly created 
hotspots, there will be at most one missing or incorrect hotspot). 

• We process your stock of drawings in the manner described under "Variant 1". 

• We will provide you with the result in the form of hotspot files (at a pre-agreed fixed price). 

Example 3: Continuous hotspot generation with a uniform method of 
drawing creation 
In your company, there is an established procedure for the creation of drawings for spare parts cata-
logs, which is adhered to by all graphic designers or model designers involved. 

You define a process in which each newly created or modified drawing is automatically provided with 
hotspots. 

Definition of a suitable configuration 

Procedure: 

• Check the drawing quality recommendations under Possibilities and limitations the extent to 
which the drawings currently being created already meet all the criteria. 

• Incorporate any necessary changes into the creation process. 

• Create a custom configuration for OCRHotspot for this type of drawing with reference character 
set, character size, and tolerance, as well as a reasonable "safe match" boundary. 

• Collect newly created or changed drawings in a special handover directory and process them 
cyclically, e.g. weekly. 

• Automatically create hotspots based on the customized configuration. 

• Check the results. 

• In the event of deviations, check the configuration and, if necessary, make adjustments there 
or arrange for a corresponding correction when creating the drawing. 

As soon as this procedure works interactively without interference, you can further automate it by using 
the "batch operation" of OCRHotspot, e.g. by incorporating hotspot generation as a post-processing 
step in the creation process of the drawings. 
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Glossary 

List of technical terms used 

Term Explanation 

Exclusion area For each configuration, one or more exclusion areas can be defined, which 
can be used to exclude certain sections of the drawing from automatic char-
acter recognition. Exclusion areas can be either "inclusive" (search only 
within the scope) or "exclusive" (search outside the scope only). In addition, it 
can be specified whether the coordinates of the exclusion areas should be 
"absolute" (i.e. in pixel coordinates, relative to the upper left corner) or "rela-
tively" (percentage, based on the drawing size). 

Electronic Spare 
Parts Catalog 

An electronic spare parts catalog is used for easy identification of spare parts, 
usually supported by graphical navigation via hotspots on the exploded views 
of the individual assemblies. 
A software compatible with OCRHotspot for the creation of electronic spare 
parts catalogs is SpareParts365 from SpareParts365 GmbH. 

Element An element is a part of a drawing file that could represent a valid character. 
Criteria: 
• Freestanding, i.e. no direct connection to other drawing parts 
• Minimum size of 3 x 3 pixels 
• Maximum size of 128 x 128 pixels 

Hotspot A hotspot is the area around an item number that is supposed to be "sensi-
tive" in an electronic catalog, i.e. to react to clicking or hovering over it with 
the mouse. A hotspot is typically slightly larger than the item number itself to 
make it easier to select with the mouse. 
A hotspot is usually in the shape of a rectangle. Alternatively, OCRHotspot 
can also be used to define elliptical or polygon hotspots. 
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Term Explanation 

Hotspot file A hotspot file is an attribute file that is created as part of a drawing file. Typi-
cally, the hotspot file is located in the same directory as the drawing file and 
has the same filename, but a different, specific filename extension (e.g. 
".hspx", ".csv"). 
The hotspot file contains an entry for each hotspot on the drawing, which in-
cludes the coordinates, the text of the position number, as well as the shape 
(rectangle, ellipse, polygon) and type (reference to item or reference to as-
sembly). 

Hotspot generation With automatic hotspot generation, the results of automatic character recog-
nition (OCR) are linked to the drawing coordinates of the relevant drawing 
section. 

Configuration A configuration consists of a set of parameters that control the detection of 
item numbers on a specific drawing type. A configuration includes the follow-
ing information: 
• Set of reference characters, each with one or more examples 
• Character size and acceptable tolerance 
• Values for reliable or approximate detection 
• Maximum spacing of characters within a position number 
• Regular expression to define valid item numbers 
• Width of the border around the location numbers that should belong to 

the area of the hotspot 
• Exclusion areas defined, if any 

OCR OCR is the abbreviation for "optical character recognition" and refers to a 
method for recognizing text in pixel graphics. OCRHotspot has a built-in OCR 
component that specializes in recognizing item numbers in drawings. 

Pixel format, pixel 
drawing 

Drawings in pixel format consist of a sequence of individual pixels, which are 
provided with a color value. A drawing element such as a line is depicted as a 
sequence of black pixels, as are the individual characters of a position num-
ber. The information as to whether a sequence of pixels is a line, a character 
or another drawing element is no longer available and must be reconstructed 
using OCR. 
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Term Explanation 

Position number, 
item number, 
(“Callout”) 

A position number is a sequence of one or more valid characters whose spac-
ing from each other does not exceed a configured maximum value. 
Typical use cases: 
• Purely numerical value, 1 - 3 digits; refers to a line in the corresponding 

BOM 
• Purely numerical value, 6 - 12 digits; material or order number of a part 
• Alphanumeric value, possibly including special characters, e.g. as loca-

tion code on circuit diagrams 

Reference charac-
ters 

A reference character must be defined for each permissible character within 
position numbers (e.g. for each digit). A reference character includes one or 
more examples of this character, e.g. from different character sets. 

Vector format, vec-
tor drawing 

Drawings in vector format contain the descriptions of the individual drawing 
elements, such as line, ellipse, curves, text, etc. 
A common format for display in vector format is SVG. The use of a tool such 
as OCRHotspot is usually not necessary for these drawing formats, as texts or 
position numbers are contained as directly usable data and can thus be used 
directly for the definition of hotspots. 

Character A character is an element of the drawing that corresponds to one of the refer-
ence characters used with sufficient accuracy and is within the currently con-
figured size tolerance for characters. 

Character recogni-
tion 

see OCR. 
Character recognition is the prerequisite for automatic hotspot generation. 

Drawing OCRHotspot can be used to process different types of drawings: 
• Exploded view of an assembly with position numbers → best suitability for 

automatic character recognition 
• Technical drawing with item numbers → usually requires manual post-

processing following automatic character recognition 
• Photo or illustration → Manual definition of hotspots over drawing areas, 

independent of position numbers 
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Term Explanation 

Drawing file File that contains a drawing in pixel form (as opposed to vector shape). Typi-
cal file formats are: 
• TIFF / Group 4 (CCITT/4) for black and white line drawings 
• PNG for colored line art 
• JPEG for photos or photorealistic illustrations 

Drawing coordinates For pixel format drawing files, each point in the drawing (pixel) has an X and a 
Y coordinate associated with it. The X-coordinate is usually calculated from 
the left edge of the drawing, the Y-coordinate from the upper edge of the 
drawing. 
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Support 
If you need support for OCRHotspot, please contact the manufacturer by email at mailto:info@wm-
itsolutions.com  

Required Information 
In order for us to help you in the best possible way, we needed some information. 

Topic 

What is it about, e.g.: 

• Installation 

• License 

• Configuration 

• Detection quality 

• Special function 

Description 

Please describe your request as precisely as possible. If possible, attach screenshots that show the 
described topic (e.g. error message). 

Environment 

Please specify the operating system version and any special features of your system configuration. 

Drawing file(s) 

If you have problems with specific drawing files, you can attach them as an attachment, preferably 
packed as a ZIP file. 

The attachment should not exceed 2 MB, otherwise use a cloud-based file transfer. 

Configuration 

If there is a question related to a specific configuration, you can save it under "Configuration→Export" 
and attach it as an attachment ( only from the "Professional" license option). 

Otherwise, please use the configuration file "OCRHotspot.ocrx" in the folder "Documents\ 
OCRHotspot". 

mailto:info@wm-itsolutions.com
mailto:info@wm-itsolutions.com
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Logging Information 

If your request refers to a reproducible error message from the program, please activate the logging 
mode ("Adjustments→Logging") and perform the action that led to the error again. 

In the directory "Documents\OCRHotspot\Logfiles" you will now find a file "Log Debug..." which con-
tains information about the error that occurred. Send this file in addition to the information described 
here. 
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References 

Drawings Used 
The drawing used in the example screenshots is from the Wikipedia article https://de.wikipe-
dia.org/wiki/Druckluftbremse_(railway). 

Link to the drawing:  
https://commons.wikimedia.org/wiki/File:Bremsanlage_eines_G%C3%BCterwagens.PNG  

Icons 
Most of the icons used in OCRHotspot are from Icons8. 

Trademark 
• SpareParts365 and the SpareParts365 logo are registered trademarks of SpareParts365 GmbH 

(www.spareparts365.com). 

• Products and product names of other manufacturers mentioned in this documentation may 
also be trademarks and are used for identification purposes only. 

 

https://de.wikipedia.org/wiki/Druckluftbremse_(railway)
https://de.wikipedia.org/wiki/Druckluftbremse_(railway)
https://commons.wikimedia.org/wiki/File:Bremsanlage_eines_G%C3%BCterwagens.PNG
https://icons8.com/
http://www.spareparts365.com/


 

 

 

Version 1.2 Page 93 of 94 

Download 

Current version of OCRHotspot 

Version 1.2.24 

Download the ZIP file from the provided download directory to your computer and unzip the file in a 
suitable folder. 

Start OCRHotspot.exe. 

Follow the instructions at Getting Started to request your license file. 

Release Notes 

Version 1.2.24 

• Migrating to .NET 8 

• Create hotspot only within frames (circles, rectangles) 

Version 1.2.23 

• Migrating to .NET 7 

• Splitting and converting PDF files 

Version 1.2.22 

• Moving to .NET 6 

• Improved handling of narrow digits and characters 

• Support for small screen sizes 

• "Special codes" in the advanced configuration to override the predefined behavior 

Version 1.2.5 

• Moving to .NET 5 

• Texts with spaces possible 

• Improved display of longer hotspot texts 

• Improved performance 

• Improved detection of related characters and separation from adjacent hotspots 
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• Batch operation extension to include parameters for paths to the license file and configuration 
file 

Version 1.2.4 

• Insecurely detected hotspots can be taken over as valid directly in edit mode 

• For hotspot file in CSV format, additional fields configurable for: file name, directory, path name 

• Better recognition of characters in very small fonts 

• Expanded range of auto-detected fonts 

• The size of the areas of the hotspot list (left) and drawing (right) can be changed by a splitter 

Version 1.2.2 

• Hotspot files in XML format (.hspx) also contain relative coordinates related to the width and 
height of the respective drawing 

• Improved color coding and highlighting of individual elements 

• Tooltip within the drawing with information about the element below the mouse pointer 


